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Prerequisiti 
Conoscenza delle funzionalità di base di ArcView (Unità n° 0), nozioni di base sulle proiezioni 
cartografiche (coordinate geografiche, scala, ecc.). 
 
 
Obiettivi Formativi 
Scelta consapevole delle proiezioni adatte alle diverse rappresentazioni/analisi dei dati 
geografici e modifica della proiezione della vista attraverso l'interfaccia di ArcView. 
 
 
Parole chiave 
Sistema di coordinate, proiezione, scala, vista, tema. 
 
 
Durata esercitazione 
1 ora 
 
 
Materiale utilizzato 
1 archivio in formato shape (triveneto_dd.shp) contenente i poligoni relativi alla 
delimitazione amministrativa dei comuni del Triveneto. I dati sono registrati in coordinate 
geografiche. 
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Introduzione 
Le mappe sono rappresentazioni bidimensionali che descrivono superfici curve. 
La trasformazione in due dimensioni dello spazio tridimensionale viene chiamata proiezione. 
Le formule matematiche che definiscono i diversi tipi di proiezione consentono di convertire le 
posizioni sulle superficie terrestre (individuate dalle coordinate geografiche longitudine 
e latitudine) in posizioni su una superficie piana. 
Questo processo comporta inevitabilmente la distorsione di una o più delle proprietà 
geometriche degli oggetti rappresentati: forma, area, distanza e direzione. 
Quando la misura "corretta" sulla carta di una di queste caratteristiche è rilevante per le 
finalità della rappresentazione (ad esempio, prendere decisioni sulla base delle misure 
effettuate), diventa importante conoscere le caratteristiche dei diversi tipi di proiezione, ovvero 
quali distorsioni vengono introdotte quando si utilizza una particolare proiezione. In prima 
approssimazione si possono indicare le seguenti caratteristiche relative alle singole proiezioni: 
�� conformi (conformal): preservano le forme di porzioni limitate di superficie. Nessuna 

proiezione è in grado di mantenere la forma di grandi superfici e ma le aree delle stesse 
possono essere fortemente distorte. 

�� equiareali (equal area): mantengono inalterate le aree degli oggetti rappresentati. Per 
ottenere questo risultato le altre proprietà vengono distorte. 

�� equidistanti (equidistant): mantengono correttamente le distanze tra alcuni punti. Nella 
maggior parte delle proiezioni equidistanti una o più linee hanno una lunghezza uguale 
(alla scala di rappresentazione) alle linee reali (ad esempio la proiezione Sinusoidale 
rappresenta l'equatore e tutti i paralleli nella loro lunghezza reale). 

�� azimutali (azimuthal): preservano la direzione (o azimut) di tutti i punti della mappa 
rispetto ad un punto specifico. 

Dato che le mappe sono rappresentate su superfici piane, le proiezioni normalmente utilizzate 
fanno ricorso a superfici geometriche che possono essere facilmente sviluppabili in superfici 
piane. Un altro modo per classificare le più comuni proiezioni di mappa è basato sulle diverse 
superfici di proiezione utilizzate. Secondo tale modalità di classificazione, le proiezioni si 
distinguono in coniche, cilindriche e planari. 
Dato che nessuna proiezione è in grado di mantenere tutte le proprietà geometriche degli 
oggetti rappresentati, è importante valutare bene quale proiezione scegliere in base all'utilizzo 
che si intende fare della mappa. 
In generale nella produzione di cartografia tematica le caratteristiche della proiezione utilizzata 
non sono rilevanti ai fini della comprensione dei fenomeni rappresentati ed analizzati. 
Così pure per le mappe a grande scala, come ad esempio le carte stradali delle città, le 
distorsioni causate dalla proiezione utilizzata non sono di solito rilevanti in quanto la superficie 
coperta dalla mappa è generalmente molto piccola. 
Per le mappe a scala regionale o continentale, dove a piccole distanze sulla carta possono 
corrispondere considerevoli distanze reali, le distorsioni introdotte dalla particolare proiezione 
utilizzata possono avere un notevole impatto. Se ad esempio l'applicazione prevede la 
possibilità di effettuare confronti fra le forme le superfici o le distanze dei vari oggetti, diventa 
importante la conoscenza delle caratteristiche della proiezione utilizzata. 
 
 
Esercitazione 
In questa sezione viene presentata e descritta brevemente la sequenza delle operazioni da 
effettuare per modificare la proiezione utilizzata per la visualizzazione dei dati geografici. 
 
1. Aprire ArcView e iniziare un nuovo progetto. È possibile salvare il progetto in qualsiasi 
momento (File -> Save Project, oppure File -> Save Project As…). La prima volta che si 
salva un nuovo progetto, ArcView apre la finestra di dialogo Save Project As da utilizzare per 
indicare il nome del progetto e la directory nella quale deve essere salvato: in questo caso 
digitare unita2.apr nel campo di testo File Name. 
 

2. Aggiungere al progetto un documento di tipo vista (doppio clic sull'icona  nella finestra 
di progetto). 
2.1 Verificare le proprietà della vista aprendo la finestra di dialogo View Properties (View -> 
Properties…): notare i valori relativi alle voci Map Units e Distance Units: entrambe sono 

  



impostate al valore unknown; è possibile modificare questi valori solo se si conoscono le unità 
di misura delle coordinate dei dati geografici e quelle che si vogliono utilizzare per la verifica 
interattiva delle distanze: ad esempio, se i dati fossero in proiezione UTM, si dovrebbe 
impostare il valore di Map Units portandolo a meters, mentre quello di Distance Units 
potrebbe essere impostato a kilometers (ma andrebbe bene una qualsiasi unità di misura 
lineare).  
2.2 Fare clic sul bottone OK per chiudere la finestra di dialogo. 
 
3. Aggiungere alla vista il tema triveneto_dd.shp (View -> AddTheme…): le coordinate del 
file sono in gradi decimali (Lon, Lat).  
3.1 Verificare nuovamente le proprietà della vista così come indicato al punto 2.1. Ora i valori 
di Map Units e Distance Units saranno rispettivamente decimal degrees e miles. 
Impostare il valore di Distance Units a kilometers. Poiché che le coordinate dei dati 
geografici sono registrate in gradi decimali, sarà possibile effettuare la proiezione "al volo" dei 
dati stessi all'interno della vista. Attualmente la proiezione è impostata a None, il che sta a 
significare che ArcView considera i dati come non proiettati. 
3.2 Fare clic sul bottone Projection per aprire la finestra di dialogo Projection Properties 
che visualizza le informazioni sulla proiezione attualmente definita per la vista attiva. I valori 
impostati dovrebbero essere Projections of the World alla voce Category e Geographic 
alla voce Type. (mantenere questi valori o modificarli se dovessero essere diversi). 
3.3 Fare clic sul bottone OK per chiudere la finestra di dialogo. 
 

4. Misurare una distanza sulla mappa (clic sullo strumento  e nuovamente clic all'interno 
della vista tante volte quanti sono i punti che individuano la linea di cui si vuole conoscere la 
lunghezza; fare doppio clic per indicare l'ultimo punto della linea). Si prenda come esempio la 
lunghezza del ponte della Libertà (che unisce Venezia alla terraferma). La distanza calcolata da 
ArcView viene visualizzata nella barra di stato (nella parte in basso a sinistra della finestra del 
programma). La distanza è calcolata in modo abbastanza preciso in quanto ArcView, non 
essendo definita alcuna proiezione, calcola le distanze basandosi sulle coordinate sferiche 
(longitudine e latitudine) dei dati. 
 
5. A questo punto modifichiamo la proiezione della vista per verificare come si modificano sia 
la forma degli oggetti grafici rappresentati che le distanze tra gli stessi.  
�� Aprire la finestra di dialogo View Properties come già visto al punto 2.1. 
�� Aprire la finestra di dialogo Projection Properties come già visto al punto 3.2. 
�� Impostare a UTM - 1983 il valore della voce Category: automaticamente viene 

modificato il contenuto della lista relativa alla voce Type che ora mostra l'elenco delle 60 
zone UTM. Vengono modificati anche i parametri che descrivono la proiezione selezionata. 

�� Dall'elenco delle zone selezionare il valore Zone 33. 
�� Fare clic sul bottone OK per chiudere la finestra di dialogo Projection Properties e 

chiudere con il bottone OK anche la finestra di dialogo View Properties. 
Immediatamente si percepisce la variazione nella visualizzazione dei dati del tema: la 
forma degli oggetti è cambiata notevolmente rispetto alla precedente proiezione. 

 
6. Ora misuriamo la distanza già misurata in precedenza al punto 4. Come si potrà notare, la 
differenza tra le due misure è estremamente piccola. La proiezione UTM, all'interno delle 
singole zone, consente di mantenere una buona approssimazione nella determinazione delle 
distanze. La rappresentazione è anche accurata per gli oggetti di piccola dimensione e, 
all'interno delle singole zone sono minime le distorsioni anche per gli oggetti più grandi. 
 
7. Si provi autonomamente a cambiare la proiezione utilizzata e a verificare la variazione nella 
forma degli oggetti e nelle distanze tra di essi. 
 
8. Prima di uscire da ArcView salvare il progetto (File -> Save Project). 
 
 

  



Approfondimento: Projection Utility 
Chi volesse approfondire la conoscenza delle procedure riguardanti le proiezioni, può avvalersi 
dell'estensione di ArcView chiamata Projection Utility. Mentre la procedura illustrata in 
precedenza consente solamente di proiettare "al volo" i dati all'interno di una vista, questa 
utility è in grado di convertire un tema salvando i dati nella proiezione prescelta. L'operazione 
viene effettuata attraverso una serie di passaggi guidati: vengono presentate alcune finestre di 
dialogo che consentono all'utente di inserire i parametri necessari per creare il file di output. 
 
 
Risorse in rete 
Sono numerosissimi i siti Internet sui quali sono trattati argomenti relativi 
alle proiezioni di mappa. Di seguito sono elencati alcuni dei più interessanti. 
 
Sito con numerosi link utili 
http://geography.miningco.com/cs/mapprojections 
 
Elementi di base, tutorials ed approfondimenti sulle proiezioni di mappa 
http://baby.indstate.edu/gga/gga_cart/gecart12.htm 
http://www.gis.psu.edu/projection/index.html 
http://www.geo.hunter.cuny.edu 
http://www.colorado.edu/geography/gcraft/notes/mapproj/mapproj_f.html 
http://www.nationalgeographic.com/features/2000/exploration/projections/index.html 
http://www.env.gov.bc.ca/gis/projectiontutorial.html  
http://www.uncc.edu/~lagaro/cwg/mapproj 
http://octopus.gma.org/surfing/imaging/mapproj.html 
http://plaza.powersurfr.com/jsavard/main.htm 
http://www.geog.mcgill.ca/courses/geo201/mapproj/mapproj.html 
http://www.epa.gov/ceisweb1/ceishome/atlas/learngeog/mapprojection.html 
http://mac.usgs.gov/mac/isb/pubs/MapProjections/projections.html 
http://atlas.gc.ca/english/carto/cart003.html 
 
Raccolta di immagini relative a numerose proiezioni di mappa 
http://www.geometrie.tuwien.ac.at/karto 
 
 
Riferimenti bibliografici 
La bibliografia sull'argomento è molto vasta. Di seguito sono citati alcuni titoli 
reperibili presso la biblioteca del C.I.R.C.E. o al Laboratorio di Informazione 
Territoriale, che consentono di approfondire gli argomenti trattati. 
 
Sull'uso delle proiezioni di mappa in ArcView 
"Uso di ArcView GIS" (manuale del software ArcView GIS 3.1), ESRI Inc., Redlands, 1996, cap.  
"Getting To Know ArcView", esercizi 11a, 11b e 11c 
S. Hutchinson, L. Daniel, "Inside ArcView GIS", OnWord Press, Santa Fe, 1997, pp. 75-78 
 
Concetti di base sulle proiezioni di mappa 
"Map Projections. Georeferencing spatial data", ESRI Inc., Redlands, 1994, cap. 1 e 2 
John P. Snyder, "Map Projections. A working manual", USGS, Washington, 1987, pp. 3-10 
M.J. Kraak, F.J. Ormeling, "Carthography. Visualization of spatial data", Addison Wesley 
Longman Limited, 1996, pp. 77-86 
Cristopher Jones, "Geographical Information Systems and Computer Cartography", Addison 
Wesley Longman Limited, 1997, pp. 61-78 

  


